VIBRATION-BASED HEALTH MONITORING OF MULTIPLE-STAGE GEAR TRAIN AND DIFFERENTIAL PLANETARY TRANSMISSION INVOLVING TEETH DAMAGE AND BACKLASH NONLINEARITY

A Thesis
presented to
the Faculty of California Polytechnic State University,
San Luis Obispo

In Partial Fulfillment
of the Requirements for the Degree
Master of Science in Mechanical Engineering

by
Andrew Patrick Sommer
September 2011
COMMITTEE MEMBERSHIP

TITLE: VIBRATION-BASED HEALTH MONITORING OF MULTIPLE-STAGE GEAR TRAIN AND DIFFERENTIAL PLANETARY TRANSMISSION INVOLVING TEETH DAMAGE AND BACKLASH NONLINEARITY

AUTHOR: Andrew Patrick Sommer

DATE: September 2011

COMMITTEE CHAIR: Xi Wu, Associate Professor of Mechanical Engineering

COMMITTEE MEMBER: Jim Meagher, Professor of Mechanical Engineering

COMMITTEE MEMBER: James Widmann, Professor of Mechanical Engineering
ABSTRACT

VIBRATION-BASED HEALTH MONITORING OF MULTIPLE-STAGE GEAR TRAIN AND DIFFERENTIAL PLANETARY TRANSMISSION INVOLVING TEETH DAMAGE AND BACKLASH NONLINEARITY

by Andrew Patrick Sommer

The objective of this thesis is to develop vibration-based fault detection strategies for on-line condition monitoring of gear transmission systems. The study divides the thesis into three sections. First of all, the local stresses created by a root fatigue crack on a pinion spur gear are analyzed using a quasi-static finite element model and non-linear contact mechanics simulation. Backlash between gear teeth which is essential to provide better lubrication on tooth surfaces and to eliminate interference is included as a defect and a necessary part of transmission design. The second section is dedicated to fixed axis power trains. Torsional vibration is shown to cause teeth separation and double-sided impacts in unloaded and lightly loaded gearing drives. The transient and steady-state dynamic loading on teeth within a two stage crank-slider mechanism arising from backlash and geometric manufacturing errors is investigated by utilizing a non-linear multi-body dynamics software model. The multi-body model drastically reduces the computation time required by finite element methods to simulate realistic operation. The gears are considered rigid with elastic contact surfaces defined by a penalty based non-linear contact formulation. The third section examines a practical differential planetary transmission which combines two inputs and one output. Planetary gears with only backlash errors are compared to those containing both backlash and tooth defects under different kinematic and loading conditions. Fast Fourier Transform (FFT) analysis shows the appearance of side band modulations and harmonics of the gear mesh frequency. A joint time-frequency analysis (JTFA) during start-up reveals the unique vibration patterns for fixed axis gear train and differential planetary gear, respectively, when the contact forces increase during acceleration.

Keywords: vibration health monitoring, malfunction diagnostics, contact mechanics, contact forces, numerical simulation, multi-body kinematic model, backlash, profile errors, chipped tooth, eccentric tooth, planetary gear, epicyclic transmission, joint time-frequency analysis
TABLE OF CONTENTS

LIST OF TABLES ............................................................................................................................... viii
LIST OF FIGURES ............................................................................................................................. ix

CHAPTER

1. INTRODUCTION ........................................................................................................................1
   1.1 Purpose ....................................................................................................................................1
   1.2 Scope .......................................................................................................................................2

2. LITERATURE REVIEW ..............................................................................................................4
   2.1 Fixed axis gears ......................................................................................................................4
   2.2 Planetary gears ........................................................................................................................5

3. TOOTH ROOT FATIGUE CRACKS INCREASE STRESS IN SPUR GEAR THROUGH DYNAMIC ENGAGEMENT CYCLE USING NON-LINEAR QUASI-STATIC CONTACT ANALYSIS ......................................................... 8
   3.1 Model development .................................................................................................................8
   3.2 Mesh development ................................................................................................................ 11
   3.3 Analysis ................................................................................................................................. 12
   3.4 Mesh convergence ................................................................................................................. 12
   3.5 Results ................................................................................................................................... 13
   3.6 Discussion ............................................................................................................................. 16

4. GEAR DEFECT MODELING OF A MULTIPLE-STAGE GEAR TRAIN ........................................ 17
   4.1 Multi-body kinematic model of a one-stage gear train .......................................................... 17
   4.2 Simulation results and discussions ....................................................................................... 19
   4.3 Multi-body kinematic model of crank-slider mechanism with ............................................. 21
   4.4 Transient response after power loss .................................................................................... 23
   4.5 Start-up simulation ................................................................................................................ 27
   4.6 Steady-state frequency domain analysis .............................................................................. 30

5. TOOTH CONTACT FORCES AND DYNAMICS IN A DIFFERENTIAL PLANETARY GEAR WITH BACKLASH AND TEETH DAMAGE .............................................................................. 33
   5.1 Modeling a differential planetary gear train with backlash and teeth damage .................33
D.3 ADAMS ...............................................................................................................................74
D.4 ADAMS contact algorithm ..................................................................................................82
# LIST OF TABLES

<table>
<thead>
<tr>
<th>TABLE</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Mesh parameters, material properties, and detailed dimensions in inches</td>
<td>9</td>
</tr>
<tr>
<td>2. Geometric parameters and simulation contact force</td>
<td>18</td>
</tr>
<tr>
<td>3. Design parameters</td>
<td>22</td>
</tr>
<tr>
<td>4. Simulation parameters</td>
<td>22</td>
</tr>
<tr>
<td>5. Design and simulation parameters</td>
<td>34</td>
</tr>
<tr>
<td>6. Dynamic conditions depicted in the Figures of Chapter 5</td>
<td>34</td>
</tr>
<tr>
<td>7. Theoretical frequencies for the differential operating mode in Hz</td>
<td>48</td>
</tr>
<tr>
<td>8. Frequencies of Fig.42</td>
<td>49</td>
</tr>
<tr>
<td>A.1. Tooth stress predicted by the Lewis-bending equation</td>
<td>57</td>
</tr>
<tr>
<td>A.2. AGMA pinion tooth stress in bending and contact fatigue for infinite life</td>
<td>58</td>
</tr>
<tr>
<td>A.3. AGMA gear tooth stress in bending and contact fatigue for infinite life</td>
<td>58</td>
</tr>
</tbody>
</table>
LIST OF FIGURES

FIGURE

1. CAD trimetric .................................................................................................................................... 8
2. Mesh with backlash and cracked pinion tooth .............................................................................. 8
3. MATLAB generated involute profile for the 23 tooth pinion ..................................................... 10
4. Shaft diameters are coupled to centerpoints, surface to surface contact interaction ............. 11
5. Mesh around pinion crack is ten times more dense ................................................................. 11
6. CPS6M plane stress triangle, quadrilateral shape functions .................................................... 12
7. Partitioned gear mesh, element density required only in the loading zone of interest ........... 12
8. Von-Mises stress proportional to model DOF due to geometric stress concentration at the tooth root ............................................................... 13
9. Maximum Von-Mises stress through the engagement cycle predicted by perfect and cracked non-linear quasi-static finite element models ................................................................. 14
10. Contact teeth pair alternating between (a) one, and (b) two during the gear engagement cycle ................................................................................ 15
11. Crack propagation with pinion at 21º ........................................................................................ 15
12. A pair of meshing gears ............................................................................................................ 17
13. Eccentric pinion tooth with chipped gear .................................................................................. 18
14. Relative displacement $S$ along the line of action with pinion initial velocity $\omega_{\text{input}} = 100$ rad/s ......................................................................................................................... 20
15. Angular velocity of the pinion with initial velocity 100 rad/s; 3 lbf-in torque applied to pinion; -3 lbf-in torque applied to gear .......................................................... 21
16. Crank-slider mechanism ............................................................................................................ 22
17. Two-stage gear train .................................................................................................................. 22
18. Geometric defects including (a) chipped tooth of Gear A, and (b) eccentric tooth of Gear C ......................................................................................................................... 23
19. Free vibration response with input shaft, 167.5 rad/s; intermediate shaft, -73.5 rad/s; output shaft, 12.5 rad/s .............................................................................................................. 24
20. Comparison of the force magnitudes in Stage 1 and Stage 2 with initial conditions: input shaft, 167.5 rad/s; intermediate shaft, -73.5 rad/s; output shaft, 12.5 rad/s ................. 25
21. Relative displacement $S$ along the line of action in Stage 2 with the initial conditions: input shaft, 167.5 rad/s; intermediate shaft, -73.5 rad/s; output shaft, 12.5 rad/s ..............................................26

22. Comparison of relative displacements $S$ along the line of action on Stage 1 and Stage 2 with step input torque 149.1 N-m ..........................................................................................28

23. Comparison of the force magnitudes in Stage 1 and Stage 2 with step input torque 149.1 N-m .........................................................................................................................28

24. Three dimensional FFT of force magnitude in Stage 1 for prescribed backlash and perfect geometry with exponential step torque 149.6 N-m on the input shaft .......................................29

25. A comparison of frequency domain components of force magnitude in Stage 1 and Stage 2 with prescribed backlash and perfect geometry ......................................................................31

26. Frequency domain components of force magnitude in Stage 2 with an eccentric gear tooth on Gear C with initial conditions: input shaft, -1.49 N-m, intermediate shaft, -5.27 N-m; output shaft, 1.99 Hz .................................................................32

27. A differential planetary gear with two inputs and one output, the ring has both internal and external teeth .............................................................................................................33

28. Chipped tooth profile .........................................................................................................................34

29. Angular velocity when initial angular velocity $\omega_{x0} = 100$ rad/s is applied to the carrier ..............................................................................................................................35

30. Contact forces when initial angular velocity $\omega_{x0} = 100$ rad/s is applied to the carrier ..............................................................................................................................36

31. Angular displacement when initial angular velocity $\omega_{x0} = 100$ rad/s is applied to the carrier ..............................................................................................................................37

32. The (a) angular velocity, and (b) contact forces when initial angular velocity $\omega_{x0} = 100$ rad/s is applied to the carrier ..............................................................................................................................38

33. Angular velocities when constant angular velocity $\omega_1 = 102.1$ rad/s is applied to the sun ..............................................................................................................................39

34. Sun-planet contact force when constant angular velocity $\omega_1 = 102.1$ rad/s is applied to the sun ..............................................................................................................................40

35. Angular velocities when constant angular velocity $\omega_1 = 102.1$ rad/s is applied to the sun ..............................................................................................................................40

36. Sun-planet contact force when the torque $T_1 = 70.5$ N-m is applied to the sun ..........................................................42

37. Sun angular velocity when the torque $T_1 = 70.5$ N-m is applied to the sun ..........................................................42

38. Angular velocity with applied step torques .....................................................................................44

39. Angular velocity when torque $T_1 = 70.5$ N-m is applied to the sun, and $T_2 = 67.9$ N-m is applied to gear 1 .................................................................................................44
40. Time and frequency domain representations of force
in the planetary and fixed axis meshes.................................................................46

41. Force magnitude in planetary mesh elements include (a) spin speed components, and
(b) modulated gear mesh frequencies....................................................................47

42. Three dimensional FFT of force magnitude in the fixed axis mesh for prescribed
backlash and chipped sun with an exponential step angular velocity on both sun and gear 1 ..50
1. INTRODUCTION

1.1 Purpose

Mechanical gear transmissions with different designs play very important roles in automobiles, helicopters, wind turbines, and other modern industries. They transmit both energy and motion and are typically exposed to various harsh loading conditions. Gear transmissions are often a high maintenance source due to load variation on the driven machine creating excessive stress on the gear teeth, and large vibration due to backlash and eccentric teeth. The gearing system is prone to a variety of potential faults. Without vibration health monitoring to ensure proper operation performance will degrade.

The General Aviation and Safety Council (GASCo) annual statistics for the UK in 2011 reports that forty-one percent of helicopter accidents caused by mechanical failure originated with a malfunction in the gearbox drivetrain. The integrity of helicopter transmission is paramount to safety because the power train provides propulsion, lift, and flight maneuvering. Fatigue cracks, material flaws, excessive backlash, and manufacturing errors are often the source of these catastrophic failures. The sudden events induced by broken teeth release a tremendous amount of energy stored in the rotating system, sometimes causing components to fail in an explosive manner. An increased reliability of rotating machinery is needed, while consistent demands from the power generation and aerospace industries provide financial incentives. Nondestructive vibration based detection, location, and analysis of damages in the early stages of fault development play important roles in the health condition monitoring of rotating machinery.

Although sophisticated vibration measurement equipment such as wireless sensors and laser transducers can detect potential faults early in their progression, it is often difficult to determine the exact cause of system vibration patterns. The spectrum is complicated by the combination of different locations of damaged gear teeth, shafts, bearings, and backlash. The design configuration and location of the transducer also have a significant effect on the available signal for on-line
detection. As a result, dynamic system modeling of gearing transmissions has gained importance to the advancement of understanding system vibration mechanisms and dynamic behavior in the presence of both tooth damage and varying backlash. Gearbox transmission systems represent a complicated non-linear dynamics problem that merits investigation.

1.2 Scope

In the first section, a virtual experiment method based on a quasi-static finite element model and non-linear contact mechanics simulation is presented. The importance of accurate geometric modeling of gear tooth involutes and center distance separation on the transient response of ideal and defective gears is demonstrated. The highly non-linear character of loading and geometry requires special attention to Hertzian contact modeling. Once modeled accurately, the contact teeth-pair alternating between one and two and associated stresses are determined, as well as the effect of a fatigue crack on the pinion root.

The second section demonstrates the transient and steady-state dynamic loading on teeth within a two-stage gear transmission arising from backlash and geometric manufacturing errors by utilizing a non-linear multi-body dynamics software model. Double sided tooth impacts and associated loading are evaluated as well as superposition of effects at a shaft intermediate to sets of gears. The frequency domain analysis reveals that an eccentric tooth on a gear installed on the intermediate shaft results in a measurable increase in force magnitude components. The amplitude of the spectral line at the first-stage gear mesh frequency increases dramatically.

In the third section, a practical differential planetary gear train which combines two inputs and one output is studied using a multi-body dynamics software model. The backlash between the sun-planet and planet-ring meshes are carefully designed and calculated to avoid teeth interference and undercut. Tooth profile errors are introduced for comparison to ideal gears. The contact mechanics model of the meshing teeth is built by careful calculation and selection of the impact algorithm parameters including the stiffness, force exponent, and damping and friction coefficients.
Planetary gears with only backlash errors are compared to those containing both backlash and tooth defects under different kinematic and loading conditions. Time domain results show that the dynamic responses depend on the interaction of many components of the differential planetary system. Fast Fourier Transform (FFT) Analysis shows the appearance of side band modulations and harmonics of the gear mesh frequency. A joint time-frequency analysis (JTFA) during start-up illustrates the unique vibration patterns when the contact forces increase during acceleration.
2. LITERATURE REVIEW

2.1 Fixed axis gears

Dubowsky and Freudenstein [1, 2] developed a theoretical model to investigate the dynamic response of a mechanical system with clearance. Based on this research, Azar and Crossley [3] explored the dynamic behaviors of the engaged gearing systems with gear backlash, time-varying stiffness and damping of the gear teeth. Compared with above investigations, Yang and Sun [4] developed a more realistic dynamic model for a spur gear system with backlash. By taking the involute tooth profile into consideration they were able to account for material compliance, energy dissipation, time-varying mesh stiffness and damping due to the contact teeth-pair alternating between one and two during the gear engagement cycle. In order to accurately simulate the dynamic behavior the gear mesh stiffness should include at least two factors: local Hertzian deformation and tooth bending. Even though the authors only considered the Hertzian contact stiffness the dynamic simulations for free vibration, constant load operation and sinusoidal excitation presented insightful results.

Two notable review papers that discuss the numerical modeling of gear dynamics are by Ö zgüven and Houser in 1988 [5] and by Parey and Tandon in 2003 [6]. Ö zgüven categorized the models as dynamic factor models, models with tooth compliance, models for gear dynamics, those for rotor dynamics, and those for torsional vibration. The listed goals for the studies included reliability, life, stress, loading, noise, and vibratory motion. Curiously, condition monitoring was not included. Early work modeled the meshing stiffness as either an average or piecewise linear variation. Parey and Tandon’s review concentrated mostly on the modeling of defects but includes an extensive compilation of various lumped parameter models. Dalpiaz et al. [7] investigated a gear pair with a fatigue crack and discussed the effectiveness and sensitivity of the time-synchronous average (TSA) analysis and cyclostationary analysis on the basis of experiment. They also discussed quefrency as a measure of harmonic amplitude in a traditional cepstrum analysis.
Parey et al. [8] developed a six DOF non-linear model for a pair of spur gears on two shafts, calculated the Hertzian stiffness for the tooth surface contact, and implemented the empirical mode decomposition (EMD) method to simulate the different defect widths. Many authors [9, 10, 11, 12] utilized different methods of estimating time-varying stiffness in order to get practical dynamic simulation results. Meagher et al. [13] presented three different dynamic system modeling strategies currently being used by researchers to identify diagnostic indicators of gear health: a strength of materials based lumped parameter model, non-linear quasi-static finite element modeling, and multi-body kinematic modeling with non-linear contact stiffness. This research contrasts these methods of modeling gear dynamics by comparing their predicted stiffness cycle and its affect on dynamic response.

Research shows that the signal patterns due to the combination of backlash, time-varying gear mesh stiffness, and involute profile errors are complicated and depend on both gear train design and configuration. In other words, the signals from a specific gearing system are difficult to interpret until a series of modeling, testing, and data processing work are completed. It is not feasible to experimentally test each type of gear train for specific fault patterns. To solve this issue a virtual experiment method based on multi-body dynamics and non-linear contact mechanics is presented. Ebrahimi and Eberhard [9] used multi-body dynamics software to model gear mesh stiffness using a rigid-elastic model. Hertzian contact at the gear interface is used to represent elasticity as a compromise over fully elastic models, thereby reducing computational effort. Kong et al. [14] modeled a large industrial gearbox used in a twelve cubic meter electric mining shovel. The non-linear contact mechanics were analyzed to predict the bearing support force variation and gear tooth loading of ideal gears and those with defects, gear backlash was not considered.

2.2 Planetary gears

The planetary gear train is widely used in transmission design of automobiles, helicopters, and aircraft engines due to the numerous advantages over traditional fixed axis transmissions. Torque capability is increased because the load being transmitted is shared between several planets.
Another notable advantage of a planetary gear is its distinctive combination of compactness and high power transmission efficiency. Despite the benefits, the complicated dynamic forces existing among sun, planet and ring gears are difficult to analyze for sources of vibration. Simulating the practical dynamic force between single-mating-gear pairs still remains as an important topic. It is more challenging to realistically model a planetary gear with multiple meshing stages. As a result, the dynamic analyses of planetary gear trains have received far less attention than fixed axis gear trains.

Lin and Parker [16] analytically investigate the parametric instability of planetary gears induced by gear mesh stiffness variation. The authors use rectangular waveforms with different contact ratios and mesh phasing to simulate the gear mesh stiffnesses existing between sun-planet and planet-ring mating pairs. Instability boundaries are directly associated with meshing parameters in the vibration modes. The authors also demonstrate some numerical simulation results about the teeth separation caused by parametric instability and strong impact in the system response. Lin and Parker [17] derive a theoretical model and carefully identify the important characteristics of the natural frequencies and vibration modes for planetary gears. The model uses three planar degrees of freedom and takes gyroscopic effects and time-varying gear mesh stiffnesses into consideration. The authors do comprehensive investigations about the distinctive characteristics of each type of mode. Guo and Parker [18] extended the two-dimensional lumped-parameter model by incorporating the factors of teeth separation, back-side contact, tooth wedging, and bearing clearances. By scrutinizing the dynamic response of an example planetary gear the authors investigate the non-linear tooth wedging behavior often observed in a wind turbine planetary gear train. More research about dynamic behavior of planetary gears can be found in reference [19, 20].

Unfortunately, the majority of current publications about planetary gears do not include the interactive effects of backlash and teeth damage.

Even a simplified ideal system model for a one-stage gear train can not accurately simulate the gear train’s practical dynamic behavior by simply assuming square-waveforms for time-varying
gear mesh stiffness. The impact forces between the mating pairs are very sensitive to the tooth profile, and backlash which must be carefully designed. Geometric simplifications used in classical modeling can be overcome by combining high resolution CAD models with multi-body dynamic simulation software.
3. TOOTH ROOT FATIGUE CRACKS INCREASE STRESS IN SPUR GEAR THROUGH DYNAMIC ENGAGEMENT CYCLE USING NON-LINEAR QUASI-STATIC CONTACT ANALYSIS

3.1 Model development

Dynamically meshing gear teeth require a high manufacturing tolerance. An external spur pair utilizing perfect involute geometry and prescribed backlash will serve as a baseline model, shown in Fig.1. A fatigue crack on the root of the pinion gear is investigated in a second model, shown in Fig.2. The geometric and material properties of this fixed axis transmission are calculated in Table 1. The \( \frac{23}{31} \) spur pair is found in a number of power trains, details provided in [24]. The elastic modulus and Poisson's ratio are representative of mid-grade through-hardened carbon steel.

MATLAB code is used to generate the tooth involute profile, shown for the pinion in Fig.3. Backlash between gear teeth which is essential to provide better lubrication on tooth surfaces and to eliminate interference is included as a defect and a necessary part of transmission design. The most common method to achieve a desired backlash is to increase the mating center distance between the shaft axes. Dimensions and prescribed backlash via the center distance method are calculated in Table 1. Adequate
thrust bearing capability is assumed in the direction normal to the gear faces. A coupling between the motor and pinion shaft effectively isolates the gearbox from the driving and driven equipment.

### Table 1. Mesh parameters, material properties, and detailed dimensions in inches

<table>
<thead>
<tr>
<th></th>
<th>Pinion</th>
<th>Gear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diametral pitch</td>
<td>10 teeth/in</td>
<td></td>
</tr>
<tr>
<td>Pressure angle</td>
<td>20 degree</td>
<td></td>
</tr>
<tr>
<td>Face width</td>
<td>1 in</td>
<td></td>
</tr>
<tr>
<td>Pinion Z_p</td>
<td>23 teeth</td>
<td></td>
</tr>
<tr>
<td>Gear Z_g</td>
<td>31 teeth</td>
<td></td>
</tr>
<tr>
<td>Backlash B</td>
<td>0.004 in</td>
<td></td>
</tr>
<tr>
<td>Center distance c</td>
<td>2.705 in</td>
<td></td>
</tr>
<tr>
<td>Contact ratio m_f</td>
<td>1.626</td>
<td></td>
</tr>
<tr>
<td>Material properties:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$E = 2.07 \times 10^{11}$ Pa</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\nu = 0.29$</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\rho = 7801 \text{ kg/m}^3$</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Two-dimensional finite element stress formulations have shown direct correspondence to the realistic transmission system. For instance, if the motor supplies 7.5 kW at 950 rpm, the applied torque becomes,

$$P_{in} = T_p \omega_p \rightarrow T_p = 667 \text{ lb-in}$$

This torque is applied to the pinion shaft diameter by defining a coupling interaction to the pinion's centerpoint. The gear is held fixed over its shaft diameter in the same manner. The boundary conditions and loading utilized in all simulations of Chapter 3 are shown in Fig.4.
The contact mechanics are modeled using the Abaqus/Standard solver algorithm. The interaction property set *surface to surface, finite sliding, hard contact tracking, frictionless tangential behavior* yielded best results. Since gear teeth transmit torque via rolling contact the tangential behavior of the contact is assumed frictionless. Energy damping inherent in dynamically meshing gears is negligible. Crack propagation is modeled as a numerical integration of the contour integrals of fracture mechanics. A 0.03 inch length crack is generated on the root diameter of the pinion, this is the known fatigue failure location of this external spur gear. The crack front, q-vector, and seam are implemented as a Special Engineering Feature, shown in Fig.2 and Fig.5.

A quasi-static stress analysis is performed by rotating both pinion and gear through a series of different geometrically valid mesh configurations. A pinion rotation of 32º encapsulates a single tooth passing through the dynamic loading zone, or engagement cycle. By rotating the pinion in 1º increments, and the gear in corresponding $\frac{23}{31}$º increments, the involute surfaces stay in contact
at each geometric configuration. Therefore, a total of thirty-two analyses were created for both the baseline and cracked models.

3.2 Mesh development

The tooth involute profile is a precise curve best approximated with triangular elements. Quadratic shape functions were chosen to ensure that bending effects were captured in the analysis. A plane stress formulation with thickness, $t = F = 1$ in, was constructed using element CPS6M of the Abaqus 6.7-3 element library, [25]. CPS6M is a six noded plane stress triangle with two translational DOF's per node, shown in Fig.6.

![Fig.4. Shaft diameters are coupled to centerpoints, surface to surface contact interaction](image)

The fatigue crack was seeded an order of magnitude larger than the involute profiles, shown in Fig.5. The faces of both gears were partitioned and appropriate edge biasing applied, shown for the gear in Fig.7. The convergence study indicates a refined mesh with a 72744 DOF pinion and a 92344 DOF gear, shown in Fig.8.

![Fig.5. Mesh around pinion crack is ten times more dense](image)
All elements used in the baseline model met the min/max angle and aspect ratio criteria, no errors or warnings were observed. Two elements were outside the suggested min/max angle in the cracked model due to the singularity at the crack tip.

3.3 Analysis

A non-linear quasi-static stress analysis is performed on a model with a perfect mesh and a mesh with a cracked pinion tooth. The contact force tolerance parameter was adjusted to 0.001 in. This parameter defines the distance between surfaces in which the solver assumes contact. According to [25], a value greater than zero increases the algorithm's accuracy and decreases computational time. The tolerance value is four times less than the backlash arclength of 0.004 in, the smallest characteristic length in the system.

3.4 Mesh convergence

The convergence study reveals a strong linear relationship between maximum Von-Mises stress and model DOF, shown in Fig.8. This result is due to the geometric stress concentration at the tooth root. Decreasing the element size (increasing model DOF) creates a smaller area for the bending force to act upon, causing an increase in stress. The number of fixed nodes along the surface representing the gear shaft does not change because the region is coarsely meshed. Therefore, the model DOF is calculated as,
Convergence results of this type are anticipated in models with discontinuous geometric stress concentrations such as those on the root diameters of this spur gear. One approach is to tune the element size such that a desired stress value is achieved. A 164,868 DOF model was selected because the predicted maximum stresses were near those obtained by classical methods.

3.5 Results

The maximum Von-Mises stress predicted by the finite element model is in close agreement with classical equations, shown in Fig.9. The Lewis-bending equation and AGMA methodology were used to predict the bending stress, details provided in Appendix A. The results of the Lewis-bending equation are \( \sigma_{\text{Lewis}} = 33.7 \text{ ksi} \).
Fig. 9. Maximum Von-Mises stress through the engagement cycle predicted by perfect and cracked non-linear quasi-static finite element models

(a) Pinion at 3° with prefect geometry
Close agreement between model and theory should be considered with respect to the convergence behavior created by the geometric stress concentration. The inclusion of the pinion root crack represents a characteristic increase in force and resulting stress magnitude between the perfect and damaged geometries.

Fig.10. Contact teeth pair alternating between (a) one, and (b) two during the gear engagement cycle

Fig.11. Crack propagation with pinion at 21°
The contact teeth-pair alternates between one and two during the gear engagement cycle, shown in Fig.10. The gear contact ratio \( m_f = 1.626 \) can be observed graphically the regions indicated in Fig.9. A root crack on the pinion has created a 99% stress increase at the single-tooth tip-contact position occurring at pinion 21°, shown in Fig.11.

3.6 Discussion

Fatigue failure due to cracked or chipped teeth is one of the most common failure modes of industrial transmission. Many engineering sectors have active research in gear fatigue and conditional health monitoring through vibration diagnostics. A broad range of fixed axis external spur gear designs can be investigated using the CPS6M plane stress element and surface to surface contact algorithm parameters presented in Chapter 3. The quasi-static formulation can be used to extract the linear tooth mesh stiffness of this spur pair, then convert to a torsional mesh stiffness by defining the centerpoint angular rotations as a function of time. This value can be compared directly to experimentally obtained results in the next stage of the finite element analysis effort.
4. GEAR DEFECT MODELING OF A MULTIPLE-STAGE GEAR TRAIN

4.1 Multi-body kinematic model of a one-stage gear train

A rigid-elastic model of a pair of meshing gears is shown in Fig.12, details provided in [24]. Fig.13 shows an eccentric pinion with a chipped gear. The gears are rigid but the contact surfaces are modeled using a penalty based non-linear contact formulation. The non-linear contact force, \( F = K(d)^e - cv \), is composed of an elastic and damping portion [15], where \( d \) is the penetration depth. The damping force, \( cv \), is proportional to impact velocity, \( v \).

The stiffness coefficient, \( K \), is taken to be the average value of stiffness over one tooth mesh cycle. The force exponent, \( e \), was determined from trial simulations. The damping coefficient generally takes a numeric value between 0.1% - 1% of \( K \). The determination of force exponents however is not obvious and must be based on experience. The ADAMS impact algorithm was chosen as the contact model because of its robustness in numerical integration. The restitution model is extremely sensitive to the duration of the contact event and is best suited for impulse type simulations. It is not optimal for time histories that include a large number of contact events in which the force vector is not known beforehand.

The stiffness parameter is reasonable for the lightly loaded medium steel pair. The response of interest occurs over a very short time interval, around one hundred milliseconds. Because damping in meshing gears is such a small percentage of the elastic force, its affect on the simulation results is negligible. Therefore, the damping coefficient is near zero to simplify the numerical solver routine.
The penetration $d_c$ is defined as the depth at which the damping force reaches its maximum value, details provided in [15]. Modification of this value does not have a significant effect on the response of either gear. The geometric mesh parameters and ADAMS contact parameters are shown in Table 2.

<table>
<thead>
<tr>
<th>Algorithm</th>
<th>ADAMS impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stiffness $K$</td>
<td>2 x 10^7 lb/in</td>
</tr>
<tr>
<td>Force Exponent $e$</td>
<td>2.2</td>
</tr>
<tr>
<td>Damping $c$</td>
<td>2 x 10^-2 lb-s/in</td>
</tr>
<tr>
<td>Penetration $d_c$</td>
<td>1 x 10^-7 in</td>
</tr>
<tr>
<td>Diametral Pitch $P_d$</td>
<td>10 teeth/in</td>
</tr>
<tr>
<td>Pressure Angle $\Phi$</td>
<td>20 deg</td>
</tr>
<tr>
<td>Face Width $F$</td>
<td>0.5 in</td>
</tr>
<tr>
<td>Pinion $Z_p$</td>
<td>23 teeth</td>
</tr>
<tr>
<td>Gear $Z_g$</td>
<td>31 teeth</td>
</tr>
<tr>
<td>Backlash $B$</td>
<td>0.004 in</td>
</tr>
<tr>
<td>Contact ratio $m_f$</td>
<td>1.626</td>
</tr>
</tbody>
</table>

The eccentric pinion and chipped gear geometries are generated by modifying the involute profile of a single tooth. The tooth chip is created by removing mass from the ideal form. Tooth eccentricity by rotating the profile along the base circle by an angle that does not cause mesh
interference. From the defined gear backlash the operational center distance of the spur pair is \( C = 2.705 \) in, details provided in [21].

4.2 Simulation results and discussions

Combined with gear profile errors backlash may cause loss of contact between gear teeth. This may induce consecutive single-sided or double-sided impacts and generate large impact forces with large vibration. \( R_p \) and \( R_g \) are the radii of the base circles of pinion and gear, respectively. The relative displacement between the two mating teeth profiles along the line of action is represented as, \( S = R_g \theta_g - R_p \theta_p \), shown in Fig.14. When \( S \) is larger than the gear backlash \( B \), there is contact between pinion and gear. For a fixed axis external spur pair,

\[-B \leq R_g \theta_g - R_p \theta_p \leq B\]

![Fig.14. Relative displacement along the line of action, \( S = R_g \theta_g - R_p \theta_p \)](image)

Fig.14 shows relative displacement \( S \) along the line of action with pinion initial velocity \( \omega_{\text{input}} = 100 \) rad/s for a perfect meshing pair and a pair with an eccentric tooth on the pinion. A back collision takes place during separation of the gear teeth. Successive double-sided impacts are observed on the alternating surfaces of the meshing pair. The early motion of Fig.15 is outside \( \pm B \) because of the surface penetration required by the impact algorithm. As time increases the penetration decreases, and the period between impacts increase for both the perfect and eccentric gear pairs.
Each point of Fig.15 defines a unique tooth configuration of the mesh. The profile error of the eccentric pinion tooth causes a greater number of oscillations to occur in a given time interval. This can be explained by considering that the tooth is larger, and therefore has less space to move within the backlash band $\pm B$. During startup the eccentric pinion tooth will contact the mating gear tooth earlier than it would with the ideal profile geometry. The frequency of impact has increased.

![Graph showing relative displacement S along the line of action with pinion initial velocity $\omega_{\text{input}} = 100 \text{ rad/s}$](image)

**Fig.15.** Relative displacement $S$ along the line of action with pinion initial velocity $\omega_{\text{input}} = 100 \text{ rad/s}$

Fig.16 plots the angular velocity of the gear for both a perfect and chipped pair with pinion initial velocity and constant applied torques. As contact with the gear occurs both the pinion and gear velocities change rapidly. The large magnitudes during the first 20 ms are due to the pinion's prescribed initial velocity. This transient response decays quickly and only the effect of the applied torques are observed. Both the pinion and gear experience single-sided impacts.
The effect of the chipped tooth with respect to the number of impacts is opposite to that of the eccentric tooth. It takes longer for the pinion to make contact with the gear because of the modified profile. Close inspection shows that the chipped gear experiences less direction changes than the perfect gear, and therefore less impacts. The chipped tooth creates a time lag in the angular velocity response as it moves through the dynamic engagement cycle.

4.3 Multi-body kinematic model of crank-slider mechanism with two-stage gear train

In order to investigate how the interaction of backlash and manufacturing errors affects the dynamic behavior and contact forces of a multiple-stage gearing system, the crank-slider mechanism shown in Fig.17 is studied. Fig.18 depicts the gearing transmission for the mechanism. The gear design and simulation parameters are calculated in Table 3 and Table 4, respectively.
Table 3. Design parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of teeth</td>
<td>$Z_a = 17; Z_b = 60; Z_c = 19; Z_d = 72$</td>
</tr>
<tr>
<td>Pitch diameter mm</td>
<td>$D_a = 68; D_b = 240; D_c = 95; D_d = 360$</td>
</tr>
<tr>
<td>Module</td>
<td>$m_1 = 4; m_2 = 5$</td>
</tr>
<tr>
<td>Gear ratio</td>
<td>13.4</td>
</tr>
<tr>
<td>Pressure angle</td>
<td>$20^\circ$</td>
</tr>
</tbody>
</table>

Table 4. Simulation parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material properties</td>
<td>$E = 2.07 \times 10^{11} \text{Pa}; \nu = 0.29; \rho = 7801 \text{kg/m}^3$</td>
</tr>
<tr>
<td>Force exponent</td>
<td>2.2</td>
</tr>
<tr>
<td>Backlash mm</td>
<td>$B_1 = 0.05; B_2 = 0.08$</td>
</tr>
<tr>
<td>Penetration</td>
<td>$10^{-7} \text{mm}$</td>
</tr>
<tr>
<td>Stiffness</td>
<td>$2 \times 10^7 \text{N/mm}$</td>
</tr>
</tbody>
</table>

Fig.17. Crank-slider mechanism

Fig.18. Two-stage gear train
The ADAMS impact algorithm was chosen for this multi-body dynamic analysis. The chipped tooth of Gear A is created by removing the mass of a single tooth, shown in Fig.19(a). An eccentric tooth on Gear C is generated by linearly translating the involute profile 0.0045 mm from the perfect geometric position, shown in Fig.19(b).

4.4 Transient response after power loss

The perfect waveform shown in Fig.20 is the response of all four gears with perfect involute profiles and prescribed backlash. The chipped curve is the response of an input pinion with a chipped tooth, all other gears have ideal profiles. The coordinate orientation is defined such that a force from the pinion to the gear is considered positive. This simulation emulates the dynamics and loading conditions of a system coast-down. The coast-down is characterized by the mechanism slowing from steady-state speed to rest in a short time interval. An initial velocity is prescribed on each shaft that corresponds to its rotary speed under standard operating conditions.

From the top two plots of Fig.20, the initial position of the gears is such that neither stage is in contact at the beginning of the simulation. This follows from the assumption that with loss of
power there will be separation of teeth due to sudden load removal and inertial effects. Therefore, all three shafts are rotating without impact until Gear C touches Gear D at 11.4 ms. Gear A touches Gear B at 14.7 ms, it causes the contacts in Stage 1 to increase in frequency for the next 20 ms. The angular velocity of the intermediate shaft is a combination of the other two shafts’ angular velocities. Double-sided impacts are evident in the y-component of force in Stage 1. When the sign of the force alternates at similar magnitude, it indicates impacts on the same tooth in alternate directions. The dynamic response of the intermediate shaft is due to a superposition of the impacts in Stage 1 and Stage 2.

![Fig.20. Free vibration response with input shaft, 167.5 rad/s; intermediate shaft, -73.5 rad/s; output shaft, 12.5 rad/s](image)

For the chipped pinion the first impacts in Stage 1 occur earlier. This is due in part to the reduction of inertia. The inertia of the perfect input pinion is $I_{zz} = 1.06 \times 10^{-3}$ kg-m$^2$, while the chipped
The chipped pinion will experience larger acceleration for a given force. The teeth neighboring the chipped tooth will contact the mating gear sooner than they would with their standard inertia.

Fig. 21 depicts the force response in Stage 2. The first and second contacts occur at nearly the same instant for both the perfect and chipped geometries. Gear D experiences three single-sided impacts during the interval for the perfect case, and only two for the chipped pinion. The force magnitude in Stage 1 is reduced during the interval $20 < t < 28$ ms as the chipped tooth of Gear A moves through the engagement cycle.

The initial velocities given to each shaft are based upon their rated operating speed. The shaft bearings are modeled without friction and constrain all degrees of freedom except for rotation in
the normal plane. The relative pitch velocity of Gear C and Gear D is slightly larger than between Gear A and Gear B, causing the first contact event to occur in Stage 2 before Stage 1. If the relative velocity between Gear A and Gear B was larger than between Gear C and Gear D, then the timing of the initial contact would be reversed. The delay in the response of Stage 2 around 18.5 ms is due to the chipped tooth on Gear A.

There are three bodies undergoing rotation in the multi-body dynamic model of the crank-slider mechanism. The first is the input shaft and Gear A; the second is Gear B, the intermediate shaft, and Gear C; the third is Gear D, the output shaft, and the crank. The inertial mass of the third body is over one order of magnitude larger than the other two bodies. Its velocity changes slower than the other two bodies due to inertial effects.

Fig. 22. Relative displacement $S$ along the line of action in Stage 2 with the initial conditions: input shaft, 167.5 rad/s; intermediate shaft, -73.5 rad/s; output shaft, 12.5 rad/s
Fig. 22 shows the relative displacement between Gear C and Gear D in Stage 2. A point on this plot defines the position within the engagement cycle of Gear C and Gear D. The contacts in Stage 1 create high frequency oscillations in the angular position of Gear C. The large scale motion of Gear C is due to the impacts in Stage 2 as Gear C rotates between the teeth of Gear D. The quantity $S = R_g\theta_g - R_p\theta_p$ for Stage 2 appears as a jagged line. The small oscillation is a direct result of the contact forces in Stage 1. When Gear C makes contact with Gear D the response becomes smoother. The oscillation remains intact but the speed of Gear D changes rapidly, making these small position changes more difficult to identify. The entire $S$ curve is shifted forward in time when a chipped tooth is present on the input pinion. Although the impacts in Stage 1 occur earlier the overall behavior of Stage 2 is delayed. The profile error causes Stage 1 to become excited, and as a result it takes longer for the contact in Stage 2 to occur.

### 4.5 Start-up simulation

A realistic step torque of the form $T(1 - e^{\tau/\tau})$ is applied to the input shaft with amplitude of 149.1 N-m at $\tau = 1$ s, to simulate a start-up accelerating condition. The step function represents the characteristic curve of an electric motor.

The gears of each mesh come to an equilibrium position in which they remain in contact, shown in Fig. 23. This is a physical constraint which must be satisfied for the system to transmit power. The driving teeth approach the surface of the driven teeth, and oscillate with less amplitude as time increases. Stage 1 has the more drastic decrease in amplitude. The $S$ waveforms of each mesh approach the surfaces indicated. The distance to each surface corresponds to the prescribed backlash of each stage.
Fig. 23. Comparison of relative displacements $S$ along the line of action in Stage 1 and Stage 2 with step input torque 149.1 N-m

Fig. 24. Comparison of the force magnitudes in Stage 1 and Stage 2 with step input torque 149.1 N-m
The impacts in both stages increase in magnitude and occur at increasingly shorter intervals of time, shown in Fig.24. The force in Stage 2 is larger because Gear D is being driven by the torque on the input shaft through the gear action of Stage 1. The large inertia must be overcome solely with the force in Stage 2. Therefore, the impacts in Stage 2 are a direct result of the impacts in Stage 1. Since energy damping is negligible, each Stage 2 impact is a summation of the preceding impacts in Stage 1. The trends in both contact forces continue up to $t = \tau$. For $t > \tau$ the torque on the input shaft becomes constant and continues to drive the system to steady-state.

Fig.25. Three dimensional FFT of force magnitude in Stage 1 for prescribed backlash and perfect geometry with exponential step torque 149.1 N-m on the input shaft
In order to demonstrate how the frequency contents of the contact force evolve over time, a joint time-frequency analysis (JTFA) is presented based on transient start-up conditions. For this procedure aliasing issues are prevented by using a large number of integration steps and a long simulation duration of 3 seconds. Spectrum leakage was reduced by overlapping a sliding time sample of 50 ms by 80% and applying a Hamming window to each sample.

The spectral components of the force in Stage 1 exhibit the exponential form of the applied input torque, shown in Fig.25. The system passes its rated operating speed around 350 ms and continues to accelerate under a start-up condition. The dominant frequencies are the three shaft spin speeds and the two gear mesh frequencies. Because the mesh pairs do not share a common factor only integer multiples of the superharmonics are considered. The largest spectral line is the first gear mesh frequency, $\text{GMF}_1 = 1653$ Hz, and the second largest is its first superharmonic, $2(\text{GMF}_1) = 3306$ Hz. The lines which originate below 100 Hz are the element spin speeds and their harmonics. The largest spin speed amplitude corresponds to the input pinion 1X which has a value of 98 Hz at $t = 600$ ms. An exponential increase in the magnitudes of each frequency line is observed, a characteristic which is not readily available in standard two dimensional plots. Fig.25 shows the trends of the transient magnitude and frequency components of the contact-dynamic force over the short time interval.

4.6 Steady-state frequency domain analysis

To obtain the frequency domain response of Stage 1 a constant angular speed is applied to the input shaft and a small resistive torque on the intermediate and output shafts, shown in Fig.26(a). The magnitude of the resistive torque is around one percent of the element's torque at steady-state. The resistive torques model the rotational friction due to bearings, couplings, and fluid shear in the realistic crank-slider mechanism. In addition, this torque decreases any large variations in force amplitude, producing a type of filter for the signal of interest in the time domain. Aside from the resistive torque on each element the system is not loaded and the resulting spectral magnitudes are below 1 kN. The frequency response of Stage 2 is obtained by assigning the output shaft a
constant angular speed, and a resistive torque on the input and intermediate shafts, shown in Fig.26(b).

The frequency components in each mesh include the gear mesh frequencies and their superharmonics. The shaft speeds and hunting tooth frequencies are absent because the perfect mesh geometry contains prescribed backlash without profile errors. If the frequency components under 100 N are noise, then the first five harmonics of the gear mesh frequency comprise nearly all the total force vectors.

For Fig.26, the Stage 1 initial conditions are input shaft, 26.7 Hz; intermediate shaft, -5.27 N-m; output shaft, -20.0 N-m. The Stage 2 initial conditions are input shaft, -1.49 N-m; intermediate shaft, -5.27 N-m; output shaft, 1.99 Hz. The coupled contact behavior in Stage 1 and Stage 2 are evident in the frequency domain as sideband modulation. The force vector in Stage 1 is modulated
by the output 1X at 1.99 Hz creating small sidebands surrounding the gear mesh and its harmonics, shown in Fig. 26(a). Similarly, the force vector in Stage 2 is modulated by the input 1X at 26.7 Hz. This creates the larger sideband modulations around the gear mesh and its superharmonics, shown in Fig. 26(b).

The presence of an eccentric tooth on Gear C creates an increase in force magnitude components below the gear mesh frequency, shown in Fig. 27. The eccentric tooth comes into mesh once per revolution causing excitation at intermediate 1X = 7.6 Hz (f1) and its superharmonics. The influence of this low spin speed excitation decreases as frequency increases. The perfect and eccentric spectra are nearly identical after the first harmonic of the gear mesh frequency. The eccentricity of Gear C causes the amplitude of the spectral line at GMF1 to increase by 50.4%. This is a potentially new and important vibration signature of the defected gear train.

Fig. 27. Frequency domain components of the force magnitude in Stage 2 with an eccentric gear tooth on Gear C with initial conditions: input shaft, -1.49 N-m, intermediate shaft, -5.27 N-m; output shaft, 1.99 Hz
5. TOOTH CONTACT FORCES AND DYNAMICS IN A DIFFERENTIAL PLANETARY GEAR WITH BACKLASH AND TEETH DAMAGE

5.1 Modeling a differential planetary gear train with backlash and teeth damage

The differential planetary gear chosen for study has two inputs and one output [21, 22, 23]. The system schematic and CAD model are shown in Fig.28(a) and Fig.28(b), respectively. The profile of the chipped sun gear tooth is shown in Fig.29. Geometric design parameters of this planetary transmission are calculated in Table 5.

Combined with profile errors, backlash may cause loss of contact between gear teeth. This may induce large impact forces associated with consecutive single-sided or double-sided impacts. The gears are rigid with contact surfaces defined with a penalty based non-linear contact formulation in the same manner as Chapter 4. The contact force, \( F = K(d)^e - cv \), is a vector quantity composed of an elastic and damping portion [15], where \( d \) is the penetration depth. The damping force, \( cv \), is proportional to impact velocity, \( v \). The stiffness coefficient, \( K \), is taken to be the average value of stiffness over one tooth mesh cycle. The force exponent, \( e \), was determined from trial simulations. The damping coefficient generally takes a numeric value between 0.1% - 1% of \( K \). The determination of force exponents however is not obvious and must be based on experience.
Table 5. Design and simulation parameters

<table>
<thead>
<tr>
<th>Number of teeth</th>
<th>Material properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>$Z_a = 20; Z_b = 94$</td>
<td>$E = 2.07 \times 10^{11}$ Pa; $\nu = 0.29$; $\rho = 7801$ kg/m$^3$</td>
</tr>
<tr>
<td>$Z_c = 37; Z_1 = 28$</td>
<td>$Z_2 = 98$</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pitch diameter mm</th>
<th>Force exponent</th>
</tr>
</thead>
<tbody>
<tr>
<td>$D_a = 40; D_b = 188$</td>
<td>2.2</td>
</tr>
<tr>
<td>$D_c = 74; D_1 = 56$</td>
<td></td>
</tr>
<tr>
<td>$D_2 = 196$</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Module</th>
<th>Backlash</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>$B_1 = 0.04$ mm; $B_2 = 0.03$ mm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Gearing ratios</th>
<th>Penetration</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.7; 1.213</td>
<td>$10^{-7}$ mm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pressure angle</th>
<th>Stiffness</th>
</tr>
</thead>
<tbody>
<tr>
<td>20º</td>
<td>$2 \times 10^7$ N/mm</td>
</tr>
</tbody>
</table>

Table 6. Dynamic conditions depicted in the Figures of Chapter 5

<table>
<thead>
<tr>
<th>Fig. No.</th>
<th>Simulation Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>31, 32</td>
<td>$\omega_{x0} = 100$ rad/s initial angular velocity applied to the carrier, fixed ring</td>
</tr>
<tr>
<td>33, 34, 35</td>
<td>$\omega_{x0} = 100$ rad/s initial angular velocity applied to the carrier, free ring</td>
</tr>
<tr>
<td>36, 37, 38</td>
<td>$\omega_1 = 102.1$ rad/s constant angular velocity applied to the sun, fixed</td>
</tr>
<tr>
<td>39, 40, 41(a)</td>
<td>$T_1 = 70.5$ N-m step torque applied to the sun, fixed ring</td>
</tr>
<tr>
<td>41(b), 42</td>
<td>$T_1 = 70.5$ N-m step torque applied to the sun, $T_2 = 67.9$ N-m applied to gear 1</td>
</tr>
</tbody>
</table>

Fig.29. Chipped tooth profile

The ADAMS simulation parameters are shown in Table 5. As a reference, the dynamic conditions presented in the Figures of Chapter 5 are shown in Table 6.
5.2 Dynamic response and discussion of a planetary gear with a fixed ring

A brake is applied to the Motor 2 input shaft which effectively fixes both the ring and gear 1. An initial angular velocity, \( \omega_{x0} = 100 \text{ rad/s} \) is applied on the carrier, shown in Fig.30. In order to be dynamically feasible the sun and carrier rotate in the same direction, and the planets in the opposite direction. The response of the planet rotations are nearly identical. Their axes are coupled to the rotating carrier, and therefore the planets make contact with both the sun and ring at nearly the same instant. Identical dynamics are observed when an initial angular velocity is applied to the sun instead of the carrier.

![Graph showing angular velocity response](image)

**Fig.30. Angular velocity when initial angular velocity \( \omega_{x0} = 100 \text{ rad/s} \) is applied to the carrier**

A *nearly symmetrical position* is used for all simulations presented in Chapter 5. To evaluate the utility of this initial position consider the transmission in an exactly symmetrical orientation. The planes of the sun and ring are parallel and each planet is in the exact center of the backlash space between the sun and ring meshes. From this position the response of each planet is identical because contact occurs at exactly the same instant for all three elements. To be more realistic this symmetrical initial position is deliberately avoided. Instead, the sun, planets, and ring are displaced from \( S = R_p\theta_p - R_g\theta_g = 0 \). This ensures contact occurs on each planet will occur at different times, and the response of Fig.31 can be simulated. The nearly symmetrical position
creates the difference in contact force magnitudes on each element. These force vectors dictate the system dynamics of the planetary transmission.

Consider the duration in Fig.31 when two or more planets experience nearly identical forces. They are load sharing and are both in contact with either the sun or ring. For discussion, the planets are given a designation of either 1, 2, or 3, respectively. Between 5 and 15 ms planet 1 is the only planet in contact with the sun, therefore planet 2 and planet 3 are traveling within their backlash. During the same interval planet 1 is not in contact with the ring. The ADAMS model includes six contact forces: three on the sun from each planet, and three on the ring from each planet. At any given instant, no force or any combination of all six forces are potentially active. The small damping prescribed in the contact formulation causes the pattern between 0 and 30 ms to slowly reduce in amplitude with time.

**Fig.31. Contact forces when initial angular velocity \( \omega_{x0} = 100 \text{ rad/s} \) is applied to the carrier**
5.3 Dynamic response and discussion of a planetary gear with a free ring

Two planar DOF are added to the model by unconstraining both the ring and gear 1 and allowing them to freely rotate. The initial velocity of the carrier is transferred into all of the transmission elements instead of only the sun and planets as with the fixed ring. The rotation of the ring's large inertial mass causes several phenomena.

The transmission elements no longer oscillate with the same frequency with respect to the initial position. From Fig.32, the system returns to its initial position at 93 ms instead of the much shorter period of 20 ms shown in Fig.30. The sun, planets, and carrier elements share the same period of 27 ms because these elements are physically coupled together. Similarly, the rotation of gear 1 is physically coupled to the ring, and they share the longer period of 93ms. The rotation of the ring has increased the system period by a factor of 3.44.

![Graph showing angular displacement](image)

**Fig.32. Angular displacement when initial angular velocity $\omega_{x0} = 100$ rad/s is applied to the carrier**

Vibration increases when an element reverses direction, shown in Fig.33. This is because of the time delay created by the change inertial resistance. With the fixed ring, the sun makes contact with a planet, and that planet makes contact with the ring. When the ring is allowed to rotate the sequence includes two new elements. The sun makes contact with a planet, the planet makes...
contact with the ring, and the ring makes contact with gear 1, which is itself freely rotating. Therefore, only inertias are contributing to the change in angular velocity because all elements are unconstrained. Between 25 and 35 ms the sun makes contact with the planets. The impact of the sun makes a larger change in the planet's rotation than if the ring was stationary. The end result is a longer angular velocity settling time as the sun converges to 250 rad/s during 27 to 37 ms.

Fig. 33. The (a) angular velocity, and (b) contact forces when initial angular velocity $\omega_{initial} = 100$ rad/s is applied to the carrier
The magnitude of the contact forces is shown in Fig.33(a). A comparison with Fig.31 yields several conclusions. The first significant impact occurs at an earlier time relative to the fixed ring configuration. The interval in which the impact takes place has also decreased. For example, the sun and planet 2 are in contact for the first 20 ms in Fig.31, but remain in contact for 15 ms in Fig.33. When the sun approaches planet 2 the ring is rotating away from the direction of contact, resulting in a shorter impact duration than for the fixed ring. The general characteristic of the curve remains intact, only the duration of the event has changed.

5.4 Dynamic response and discussion of a planetary gear with constant velocity from the sun

The ring is held fixed and the sun is being driven by Motor 1 which has a constant angular speed of 102.1 rad/s = 975 rpm. Fig.34 shows the magnitude of each element's angular velocity. The planet gears must be rotating in a direction opposite that of the sun and carrier for the engagement to be dynamically feasible. During the first few milliseconds the angular velocities change rapidly, then converge to an average speed consistent with their respective gearing ratios.

![Fig.34. Angular velocities when constant angular velocity $\omega_1 = 102.1$ rad/s is applied to the sun](image)

The planet inertia is much smaller than the carrier assembly. Since the planets experience forces from the sun and internal ring, their angular velocities have a larger change in amplitude. These
oscillations reduce quickly because the system is being driven by the kinematic constraint of a constant angular speed, which defines angular velocity \( \omega \) as a function of time, \( \omega = \omega(t) \). Therefore, the sun will have the prescribed motion regardless of any force it experiences, causing the system to reach steady-state rapidly.

**Fig.35.** Sun-planet contact force when constant angular velocity \( \omega_1 = 102.1 \text{ rad/s} \) is applied to the sun

**Fig.36.** Angular velocities when constant angular velocity \( \omega_1 = 102.1 \text{ rad/s} \) is applied to the sun

The sun and planet 1 share a force history with several distinct patterns, shown in Fig.35. The two largest peaks are when the sun is in contact with only one planet. Two planets account for the next four largest peaks, and the three peaks around 20 ms are when all three planets are in contact with
the sun. The force between the sun and this particular planet is reduced when the sun is in contact with other planets, depicting the dynamic nature of the sun contact ratio.

Consideration of a sun with a chipped tooth is shown in Fig.36. Between 1 and 3 ms the magnitude of the angular velocity has increased. This is because the planet has more room to move in the larger backlash induced by the damaged tooth. An impact force causes a change in angular acceleration which propagates further because of the profile gap. The response of the perfect involutes and chipped planets become nearly identical after 10 ms because the damaged tooth has moved through the engagement cycle.

5.5 Dynamic response and discussion of a planetary gear with a step torque applied to the sun

With a fixed ring, a realistic step torque of the form \( T(1 - e^{t/\tau}) \) is applied to the sun input shaft to represent an electric motor, with magnitude and time constant derived from rated conditions. Compare the contact force magnitude of Fig.37 with Fig.35. The first large magnitude occurs at 9 ms for constant input speed, while the same magnitude here does not occur until 25 ms. An applied torque creates an angular acceleration which acts against the resistive inertia of the sun. This causes the force response to become delayed relative to the constant speed case. The largest magnitudes occur when this planet is the only planet in contact with the sun. The smaller magnitudes are due to the load sharing resulting from the dynamic sun contact ratio. The chipped sun experiences fewer impact events than the sun with standard involute profiles, shown in Fig.38. It takes longer for the gears to contact due to the damaged tooth. The chipped sun experiences larger velocity changes because the torque has accelerated the sun for a longer time before contact.
These velocity changes create large force magnitudes. The oscillations dissipate quickly as the system accelerates and contact between gear teeth becomes constant along one side only. Velocity
changes from positive to negative, like those shown in Fig.38, represent double-sided impacts induced by torsional vibration.

5.6 Dynamic response and discussion of a planetary gear with a step torque applied to both the sun and gear 1

The system is operating in differential mode with Motor 1 and Motor 2 operating in the same direction. A step torque of the form $T(1 - e^{t/\tau})$ is applied to both the sun and gear 1 to represent an electric motor, with the magnitude and time constant derived from rated conditions.

With a fixed ring as in Fig.39(a), the sun exhibits the form of the step function used to model the input torque. The sun oscillates with the largest amplitude because it has the smallest inertia. The planets dissipate energy from the sun input to the carrier output. The three planets must accelerate the carrier's large inertia from rest. The amplitude of the sun's velocity change is reduced with the system operating as a differential transmission, shown in Fig.39(b).

(a) Fixed ring, $T_1 = 70.5 \text{ N-m}$
Operating in the differential mode the ring and carrier move in the same direction as the applied torque on the sun. This makes the magnitude of the sun's angular velocity change more smooth compared to the simple planetary configuration with a fixed ring. The same effect is seen in the
other elements. The detrimental effects of the sun's chipped tooth are reduced with the system operating in the differential mode.

The mesh between gear 1 and ring has a smaller prescribed backlash than the sun and planet meshes. Therefore, contact occurs in this external fixed axis mesh before the sun and planets. A clear succession of impacts shown in Fig.40. The interval from 3.5 ms to 4.5 ms shows that as gear 1 contacts the ring, the ring contacts a planet, and the planet contacts the sun. The planets can simultaneously be in contact with the sun and ring. This complication means that the force in the fixed axis mesh directly affect the magnitude of the force between a planet and ring, shown as the 10 N peak at 7.5 ms. The dynamic response of the planet is due to a superposition of the impacts in its sun and ring meshes.

5.7 Steady-state frequency domain simulation results and discussion

The system is operating in the differential mode, with Motor 1 and Motor 2 operating in opposite directions. Constant angular velocities of 16.3 Hz = 975 rpm, and -12.4 Hz = 745 rpm, are applied to the sun and gear 1, respectively. A small resistive torque is applied to both the ring and carrier assembly. The value of the resistive torques are around one percent of the element's torque at steady-state. This resistive inertia models the frictional torque generated by the bearings, couplings, and fluid shear of the realistic planetary transmission. For testing purposes, a standard feedback control system can maintain the constant input speed on both shafts.

The predicted spectrum includes harmonics of gear mesh frequencies and element spin speeds. Predicted frequencies up to 1000 Hz are calculated in Table 7. The sun, planet, and internal ring share the same planetary gear mesh frequency denoted as GMF_{abc}. The fixed axis mesh between gear 1 and the ring (gear 2) is denoted as GMF_{12}. This fixed axis mesh is characterized by a common factor of 14, therefore the n/CF subharmonics are included in the predicted spectrum. The abc12 naming convention is consistent with the schematic of Fig.28(a). Both the planetary
and fixed axis meshes have unique force histories when the transmission is operating in the
differential mode, shown in Fig.41 for prescribed backlash and ideal involute profiles.

![Graph](image1.png)

**Fig.41. Time and frequency domain representations of force in the planetary and fixed axis meshes**

The fixed axis mesh between gear 1 and gear 2 is independent from the coupled kinematics of the
planetary meshes. The largest amplitudes correspond to the gear meshing frequencies. The
sidebands in the planetary mesh are modulations of sun spin speed because the sun is driven by
Motor 1. Similarly, sidebands in the fixed axis mesh are modulated by the gear 1 spin speed
because it is driven by Motor 2. The time and frequency domains of each mesh are shown in
Fig.41.
Fig. 42. Force magnitude in planetary mesh elements include (a) spin speed components, and (b) modulated gear mesh frequencies
Table 7. Theoretical frequencies for the differential operating mode in Hz

<table>
<thead>
<tr>
<th>Frequency</th>
<th>1X</th>
<th>2X</th>
<th>3X</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMF_{ab}</td>
<td>209</td>
<td>419</td>
<td>628</td>
</tr>
<tr>
<td>GMF_{12}</td>
<td>347</td>
<td>695</td>
<td>1042</td>
</tr>
<tr>
<td>1/14</td>
<td>25</td>
<td>50</td>
<td>74</td>
</tr>
<tr>
<td>2/14</td>
<td>50</td>
<td>99</td>
<td>149</td>
</tr>
<tr>
<td>3/14</td>
<td>74</td>
<td>149</td>
<td>223</td>
</tr>
<tr>
<td>4/14</td>
<td>99</td>
<td>199</td>
<td>298</td>
</tr>
<tr>
<td>5/14</td>
<td>124</td>
<td>248</td>
<td>372</td>
</tr>
<tr>
<td>6/14</td>
<td>149</td>
<td>298</td>
<td>447</td>
</tr>
<tr>
<td>7/14</td>
<td>174</td>
<td>347</td>
<td>521</td>
</tr>
<tr>
<td>8/14</td>
<td>199</td>
<td>397</td>
<td>596</td>
</tr>
<tr>
<td>9/14</td>
<td>223</td>
<td>447</td>
<td>670</td>
</tr>
<tr>
<td>10/14</td>
<td>248</td>
<td>496</td>
<td>745</td>
</tr>
<tr>
<td>11/14</td>
<td>273</td>
<td>546</td>
<td>819</td>
</tr>
<tr>
<td>12/14</td>
<td>298</td>
<td>596</td>
<td>894</td>
</tr>
<tr>
<td>13/14</td>
<td>323</td>
<td>645</td>
<td>968</td>
</tr>
<tr>
<td>1</td>
<td>347</td>
<td>695</td>
<td>1042</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Spin Speed</th>
<th>1X</th>
<th>2X</th>
<th>3X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ring f_r</td>
<td>3.6</td>
<td>7.1</td>
<td>10.7</td>
</tr>
<tr>
<td>Carrier f_c</td>
<td>5.8</td>
<td>11.6</td>
<td>17.3</td>
</tr>
<tr>
<td>Planet f_p</td>
<td>6.1</td>
<td>12.3</td>
<td>18.4</td>
</tr>
<tr>
<td>Gear 1 f_1</td>
<td>12.4</td>
<td>24.8</td>
<td>37.2</td>
</tr>
<tr>
<td>Sun f_s</td>
<td>16.3</td>
<td>32.5</td>
<td>48.8</td>
</tr>
</tbody>
</table>

The element spin speeds and their superharmonics are contained in the first 50 Hz of the planetary mesh spectrum, shown in Fig.42(a). The spin speed of the sun has the largest amplitude because the planetary mesh is driven by its constant angular velocity. The impacts in the fixed axis pair are transmitted to the elements in the planetary mesh through the ring. This force propagation causes a reduction in the amplitude of the gear 1 spin speed and its superharmonics when observed from the planetary mesh spectrum.

The planetary gear mesh frequency is modulated by the sun spin speed and its subharmonics, shown in Fig.42(b). The sun spin speed subharmonics are a function of the number of planet gears calculated in Table 8. The subharmonics create wide 50 Hz sidebands around the gear mesh frequency. The fixed axis meshing frequency appears in the planetary mesh spectrum when a chipped tooth is included on the sun. The magnitude of the effect is reduced when an eccentric tooth is included on a planet.
The fixed axis gear mesh frequency is modulated by the sun spin speed and its subharmonics although it is not included in the planetary mesh elements. The presence of GMF\text{12} in the planetary mesh FFT indicates damage on a sun tooth. This is a potentially new and important vibration signature of the defected gear train.

<table>
<thead>
<tr>
<th>Sideband</th>
<th>Point</th>
<th>Hz</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMF_{abc} ± \frac{1}{3}f_s</td>
<td>1</td>
<td>215</td>
</tr>
<tr>
<td>GMF_{abc} ± \frac{1}{2}f_s</td>
<td>2</td>
<td>221</td>
</tr>
<tr>
<td>GMF_{abc} ± f_s</td>
<td>3</td>
<td>226</td>
</tr>
<tr>
<td>GMF_{abc} ± 2f_s</td>
<td>4</td>
<td>242</td>
</tr>
<tr>
<td>GMF_{12} ± \frac{1}{3}f_s</td>
<td>5</td>
<td>352</td>
</tr>
<tr>
<td>GMF_{12} ± \frac{1}{2}f_s</td>
<td>6</td>
<td>358</td>
</tr>
<tr>
<td>GMF_{12} ± f_s</td>
<td>7</td>
<td>363</td>
</tr>
<tr>
<td>GMF_{12} ± 2f_s</td>
<td>8</td>
<td>380</td>
</tr>
<tr>
<td>2\times(GMF_{abc}) ± \frac{1}{3}f_s</td>
<td>9</td>
<td>424</td>
</tr>
<tr>
<td>2\times(GMF_{abc}) ± \frac{1}{2}f_s</td>
<td>10</td>
<td>430</td>
</tr>
<tr>
<td>2\times(GMF_{abc}) ± f_s</td>
<td>11</td>
<td>435</td>
</tr>
<tr>
<td>2\times(GMF_{abc}) ± 2f_s</td>
<td>12</td>
<td>451</td>
</tr>
</tbody>
</table>

### 5.8 Joint time-frequency analysis (JTFA)

In order to demonstrate how the frequency content of force changes with time a joint time-frequency analysis (JTFA) is performed based on transient start-up conditions. Fig.43 is created from the force history between gear 1 and the external teeth of the ring. The fixed axis force vector is chosen for study because of its unique interaction with the ring. The ring makes direct contact with all elements in the transmission except the sun. Therefore, the force vector between gear 1 and the ring contains information about the dynamics of the entire system. An exponential step of the form \( \omega(1 - e^{t/\tau}) \) is applied to both the sun and gear 1 to represent a characteristic electric motor. The magnitudes are -78.0 rad/s for gear 1, and 102.1 rad/s for the sun, with \( \tau = 1000 \) ms.

A resistive torque is applied to both the carrier assembly and the ring, with a magnitude around one percent of the element's torque at steady-state. Aliasing issues are prevented by using a large
number of integration steps and a long simulation duration of 4 seconds. Spectrum leakage is reduced by overlapping a sliding time sample of 100 ms by 98% and applying a Hamming window to each sample.

Fig. 43. Three dimensional FFT of force magnitude in the fixed axis mesh for prescribed backlash and chipped sun with an exponential step angular velocity on both sun and gear 1

Due to the nonlinearity caused by the interaction of the damaged tooth and different backlash, a large number of contact events are created which occur at nearly random intervals. The random
nature of the impacts produces a frequency domain with some noise. The low amplitude peaks observed between 1250 Hz and 1450 Hz continue until approximately 5000 Hz, with frequencies greater than 5000 Hz near zero.

At 760 ms the second harmonic of the fixed axis gear mesh GMF_{12} is identified as the largest peak at 650 Hz. This value is less than the 695 Hz listed in Table 7 because the system has not accelerated to its full operating speed at \( \tau = 1000 \) ms. The 3X(sun) speed is a strong excitation because of the chipped sun tooth. The damaged tooth rotates through a planet mesh three times per revolution. Therefore, the 3X(sun) speed is not a harmonic but rather the fundamental excitation of the chipped sun. The four largest peaks along the 760 ms line are modulated by the 3X(sun) frequency. The second harmonic of 2(GMF_{12}) dominates the spectrum through the 650 to 1000 ms range with sidebands also equal to 3X(sun). The sidebands increase in frequency along with system speed to their final value of 48.8 Hz at 1000 ms. An increase in the separation between peaks is observed. Along the 1000 ms line the third harmonic of 3(GMF_{12}) = 1042 Hz is present with sidebands of 3X(sun). The fourth harmonic of 4(GMF_{abc}) = 838 Hz falls in this region with magnitudes comparable to the GMF_{12} harmonics. It notable that the fundamental GMF_{12}, GMF_{abc}, and 2(GMF_{abc}) are not the dominant frequencies during start-up.

The curvature in the spectral lines in the time domain is due to the acceleration of the ring. As the system accelerates from rest, the first contacts occur from gear 1 to the ring, and from the sun to each planet. The ring and planets oscillate within their backlash at high frequency because velocity is not prescribed on these elements. The ring accelerates away from the direction of contact up to 350 Hz, causing the contacts with gear 1 and the planets to occur at increasingly longer intervals. The ring's acceleration away from the direction of contact causes the frequency of all spectral lines to decrease. The opposite occurs during the interval of 350 ms to 450 ms. Here the ring decelerates slightly, decreasing the interval between contacts and causing an increase in spectral frequency. The magnitude of oscillation in the ring's acceleration diminishes with time with all spectral lines remaining straight for \( t > \tau \).
6. CONCLUSIONS

6.1 Conclusion

A non-linear quasi-static contact analysis has been performed on two finite element models. The baseline investigates the dynamic engagement cycle with perfect involute profiles and center distance backlash. The second model includes the effect of a fatigue crack emanating from the pinion tooth root. The force and resulting Von-Mises stress varies as the contact pair alternates between one and two through the dynamic engagement cycle. The fatigue crack increases force and resulting stress by 99% at the critical tip-contact configuration.

A non-linear multi-body dynamic software model has been developed for a two stage crank-slider mechanism to demonstrate dynamic loading on gear teeth with defects during transient, start-up, and steady-state operation. The stiffness, force exponent, damping, and friction coefficients for the ADAMS impact force algorithm has been presented. The dynamic behavior of the mechanism’s intermediate shaft is shown to be a superposition of the impact forces acting in each mesh. The geometric profile error of a chipped tooth on the input pinion causes a delay in the contact forces in the second stage. A joint time-frequency analysis (JTFA) on a transient start-up simulation reveals spectral components which increase in both frequency and magnitude as the crank accelerates through its operating speed. Fast Fourier Transform (FFT) analysis of steady-state operation demonstrates that the spectrum includes the gear mesh frequencies and their harmonics.

A practical differential planetary gear train which combines two inputs and one output has been investigated using a non-linear multi-body dynamics model. To avoid interference and undercut the backlash between the sun-planet and planet-ring meshes are precisely defined. When the transmission operates with a fixed ring and undergoes free vibration from a near symmetrical position, six contact forces are potentially active. The magnitude of the contact forces depend on
the time varying contact ratios of each element. The duration of the contact event decreases with a freely rotating ring and applied initial velocity.

Step torques of opposite directions to each input shaft closely model the constraints and loading conditions of realistic operation. The dynamics of the differential mode are shown to be less destructive to the sun. The characteristics observed in the time and frequency domains are due to the interaction of many components of the differential planetary transmission. Fast Fourier Transform (FFT) analysis shows harmonics of the gear mesh frequency with varying sideband modulation. A joint time-frequency analysis (JTFA) during start-up reveals unique vibration patterns when the contact forces increase during acceleration.

6.2 Future research

The finite element model has been validated and prepared for a torsional stiffness formulation. Results of this analysis can be compared to experimental vibration data collected with a GE ADRE SXP 408 data acquisition system installed with a two-stage fixed axis gearbox. This DAQ includes a wide variety of signal processing capabilities and offers the potential to investigate new parameters of interest. Multi-body dynamic software models and MATLAB codes are currently being developed to make the valuable comparisons between simulation and experiment. The results developed from these sources will be combined into a formal publication.


A. STRESS ANALYSIS OF SPUR PAIR USING LEWIS-BENDING AND AGMA METHODOLOGY

Two industry accepted methods which define the stress on dynamically engaging gear teeth are presented. The simplest approach is the Lewis-bending equation,

$$\sigma_{\text{lewis}} = \frac{K_v W^t}{m F Y}$$

The Lewis-bending results include the assumption that both gears have a cut or milled profile, calculated in Table A.1. This formulation yields an appropriate stress magnitude and is used for comparison with the FEM results.

Table A.1. Tooth stress predicted by the Lewis-bending equation

<table>
<thead>
<tr>
<th></th>
<th>$K_v$</th>
<th>$W^t$</th>
<th>$m$</th>
<th>$F$</th>
<th>$Y$</th>
<th>$\sigma_{\text{Lewis}}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pinion</td>
<td>1.095</td>
<td>767</td>
<td>0.1</td>
<td>1.0</td>
<td>0.334</td>
<td>25.2</td>
</tr>
<tr>
<td>Gear</td>
<td>1.095</td>
<td>1394</td>
<td>0.1</td>
<td>1.0</td>
<td>0.362</td>
<td>42.2</td>
</tr>
</tbody>
</table>

$\sigma_{\text{avg}} = 33.7$

A more rigorous approach is the AGMA methodology. AGMA evaluates stress with respect to infinite life, or $10^7$ cycles. Two types of failure modes are considered, failure due to bending fatigue using quantities $\sigma_{\text{all}}$, $\sigma_{\text{act}}$, $S_F$, and failure due to pitting through quantities, $\sigma_{c,\text{all}}$, $\sigma_{c,\text{act}}$, $S_H$. The equations are defined using Hertzian contact theory and a number of geometric, manufacturing, loading, and environmental factors.

$$\sigma_{\text{all}} = \frac{S_t Y_N}{S_F Y_0 Y_Z}$$

$$S_F = \frac{S_t Y_N}{K_T K_R \sigma_{\text{act}}}$$

$$\sigma_{\text{act}} = W^t K_o K_v K_s \frac{1}{F m_t} \frac{K_H K_B}{Y_j}$$

$$\sigma_{c,\text{all}} = \frac{S_c Z_N Z_W}{S_H Y_0 Y_Z}$$

$$S_H = \frac{S_c Z_N C_H}{K_T K_R \sigma_{c,\text{act}}}$$

$$\sigma_{c,\text{act}} = Z_e \left( \frac{W^t K_o K_v K_s}{F d_p Z_1} \right)^{1/2} \frac{K_H Z_R}{Z_1}$$
The following assumptions are made for both gears: carburized through hardened grade 3 steel, uncrowned teeth, straddle mounted, open gearing, and the temperature of the lubrication is kept within its recommended range.

AGMA is usually considered conservative because it evaluates stress with respect to infinite life. Automotive transmissions for instance, do not fall into the infinite life category. Safety factors less than one for both bending and contact fatigue are noted with this criteria in mind. The results of the AGMA methodology are calculated in Table A.2 and Table A.3.

### Table A.2. AGMA pinion tooth stress in bending and contact fatigue for infinite life

<table>
<thead>
<tr>
<th>K&lt;sub&gt;o&lt;/sub&gt;</th>
<th>Z&lt;sub&gt;R&lt;/sub&gt;</th>
<th>K&lt;sub&gt;a&lt;/sub&gt;</th>
<th>C&lt;sub&gt;H&lt;/sub&gt;</th>
<th>Y&lt;sub&gt;N&lt;/sub&gt;</th>
<th>Y&lt;sub&gt;Z&lt;/sub&gt;</th>
<th>Y&lt;sub&gt;o&lt;/sub&gt;</th>
<th>K&lt;sub&gt;o&lt;/sub&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>K&lt;sub&gt;T&lt;/sub&gt;</td>
<td>K&lt;sub&gt;R&lt;/sub&gt;</td>
<td>Z&lt;sub&gt;N&lt;/sub&gt;, Z&lt;sub&gt;W&lt;/sub&gt;</td>
<td>Z&lt;sub&gt;e&lt;/sub&gt; psi&lt;sup&gt;1/2&lt;/sup&gt;</td>
<td>C&lt;sub&gt;pf&lt;/sub&gt;</td>
<td>K&lt;sub&gt;m&lt;/sub&gt;</td>
<td>K&lt;sub&gt;II&lt;/sub&gt;</td>
<td>Y&lt;sub&gt;J&lt;/sub&gt;</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2300</td>
<td>-0.003</td>
<td>1.257</td>
<td>1.257</td>
<td>0.340</td>
</tr>
<tr>
<td>Z&lt;sub&gt;I&lt;/sub&gt;</td>
<td>K&lt;sub&gt;x&lt;/sub&gt;</td>
<td>σ&lt;sub&gt;all&lt;/sub&gt; ksi</td>
<td>σ&lt;sub&gt;act&lt;/sub&gt; ksi</td>
<td>S&lt;sub&gt;F&lt;/sub&gt;</td>
<td>σ&lt;sub&gt;c,all&lt;/sub&gt; ksi</td>
<td>σ&lt;sub&gt;c,act&lt;/sub&gt; ksi</td>
<td>S&lt;sub&gt;H&lt;/sub&gt;</td>
</tr>
<tr>
<td>0.107</td>
<td>2.499</td>
<td>75</td>
<td>142</td>
<td>0.529</td>
<td>175</td>
<td>3220</td>
<td>0.295</td>
</tr>
</tbody>
</table>

### Table A.3. AGMA gear tooth stress in bending and contact fatigue for infinite life

<table>
<thead>
<tr>
<th>K&lt;sub&gt;o&lt;/sub&gt;</th>
<th>Z&lt;sub&gt;R&lt;/sub&gt;</th>
<th>K&lt;sub&gt;a&lt;/sub&gt;</th>
<th>C&lt;sub&gt;H&lt;/sub&gt;</th>
<th>Y&lt;sub&gt;N&lt;/sub&gt;</th>
<th>Y&lt;sub&gt;Z&lt;/sub&gt;</th>
<th>Y&lt;sub&gt;o&lt;/sub&gt;</th>
<th>K&lt;sub&gt;o&lt;/sub&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>K&lt;sub&gt;T&lt;/sub&gt;</td>
<td>K&lt;sub&gt;R&lt;/sub&gt;</td>
<td>Z&lt;sub&gt;N&lt;/sub&gt;, Z&lt;sub&gt;W&lt;/sub&gt;</td>
<td>Z&lt;sub&gt;e&lt;/sub&gt; psi&lt;sup&gt;1/2&lt;/sup&gt;</td>
<td>C&lt;sub&gt;pf&lt;/sub&gt;</td>
<td>K&lt;sub&gt;m&lt;/sub&gt;</td>
<td>K&lt;sub&gt;II&lt;/sub&gt;</td>
<td>Y&lt;sub&gt;J&lt;/sub&gt;</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2300</td>
<td>-0.009</td>
<td>1.251</td>
<td>1.251</td>
<td>0.367</td>
</tr>
<tr>
<td>Z&lt;sub&gt;I&lt;/sub&gt;</td>
<td>K&lt;sub&gt;x&lt;/sub&gt;</td>
<td>σ&lt;sub&gt;all&lt;/sub&gt; ksi</td>
<td>σ&lt;sub&gt;act&lt;/sub&gt; ksi</td>
<td>S&lt;sub&gt;F&lt;/sub&gt;</td>
<td>σ&lt;sub&gt;c,all&lt;/sub&gt; ksi</td>
<td>σ&lt;sub&gt;c,act&lt;/sub&gt; ksi</td>
<td>S&lt;sub&gt;H&lt;/sub&gt;</td>
</tr>
<tr>
<td>0.107</td>
<td>2.056</td>
<td>75</td>
<td>195</td>
<td>0.384</td>
<td>175</td>
<td>338</td>
<td>0.268</td>
</tr>
</tbody>
</table>
**B. ABAQUS CAE SPUR PAIR TWO-DIMENSIONAL FINITE ELEMENT MODEL USING SOLIDWORKS CAD GEOMETRY**

**B.1 Solidworks**

Create a new part. File → New → Part

Draw the pinion profile as a sketch only, do not extrude.

Save sketch in STEP file format.

File → Save As → type: STEP (*.stp)

Options button, choose these settings.

Name the file "Sinion.stp", Click OK → Save

Using the same process create a new part and sketch the gear with name "Sgear.stp".
B.2 ABAQUS CAE

Create a new model. File → New → Model

Import the sketch. File → Import → Sketch

Select the pinion sketch, click OK. Error message will appear.

Choose dismiss. This error is irrelevant, the sketch has imported correctly.

Using same process import the gear sketch into the model.

Two sketches are in the model tree.
Create a new part. Part → Create

Choose these settings, click Continue
Click open sketch icon. Click OK. Translate the sketch the desired center distance to create backlash, or click Done. Using the same process save the gear sketch to a new part.

Two parts are in the model tree.

Assemble the parts and mesh using standard procedures.
C. MSC. ADAMS EXTERNAL SPUR PAIR BACKLASH MODEL USING SOLIDWORKS CAD GEOMETRY

C.1 Solidworks

Using MATLAB codes generate two external spur gear profiles with design parameters,

\[ m = 2 \]
\[ Z_1 = 23 \text{ teeth} \]
\[ Z_2 = 31 \text{ teeth} \]
\[ F = 10 \text{ mm} \]

Pinion bore diameter = 20 mm

Gear bore diameter = 30 mm

Save As → parasolid (*.x_t) with filenames "pinion23.x_t" and "gear31.x_t".

C.2 ADAMS import

Create a new model with default settings.

File → Import

Choose the settings by right-click → Browse
Change the grid settings. Settings → Working Grid

Right-click part, Rename → "pinion23"

Right-click part, Modify → assign mass using material type: steel

Press Shift + I for an isometric view.
C.3 MATLAB

Backlash is created using operational radii calculated by the center distance method.

Using MATLAB codes,

```matlab
>> backlash

backlash = 0.500000

operational pinion radius = 23.276983
operational gear radius = 31.373325
operational center distance = 54.650307

iteration count = 6.000000
```

C.4 ADAMS simulation

Left-click the pinion to select the part, it will become highlighted.
Edit → Move, Translate to the operational radius in the + y-direction by entering a value and clicking . Create a revolute joint at the CM location of the pinion, choose "2 Bod- 1 Loc" and "Normal to Grid." The pinion is now in the correct location. Using the same process translate the gear to its operational radius and create a second revolute joint.

Right-click, Appearance → change icon size.

Press Shift + F for a front view. The model should have noticeable backlash.

Define a restitution contact force between the pinion and gear using default settings.

Right-click pinion → Modify → add an initial velocity to the CM x-axis.

Create a new pinion23 marker at the part's CM location, click Add to Part. Translate this marker in the y-direction +20 mm (arbitrary) using Edit→ Move, this is the first marker. Create a new ground marker in the same location, this is the third marker. The second marker will be the part CM.
Build → Measure → Angle → New and enter the information using right-click → Browse. The first and third marker names may differ, the second marker should be the part CM. Using same process create an angle measure for the gear's rotation. Set the simulation to End Time 0.01 and Steps 1000, click Run.

The involute profile can be used to show that backlash measured along the common normal line has the relationship,

\[ B > R_{b1} \theta_1 - R_{b2} \theta_2 > -B \]
Build → Measure → Function → New, and enter the following.

Open the ADAMS Post-Processor by clicking \( \text{ Cavalier } \). An overlay plot of angular position is shown using Add Curves. Source → Objects to view the angular velocity.

The inertia of the 23 tooth pinion is only slightly less than the 31 tooth gear. A 20:50 mesh ratio has a larger difference in inertia. The variation in the pinion and gear dynamics is more evident.
with the 20:50 pair, the results are in close agreement with literature [4]. For comparison, a
gear geometry with an eccentric pinion, and an eccentric pinion meshing with a worn gear, is shown in
the plots. Discussion of kinematic motion, torque, and step functions is discussed in Appendix D.
C.5 ADAMS examples

Initial velocities.

Input torque, resistive torque, and initial velocities.
Sinusoidal input torque characterizes system.
D. MSC.ADAMS KINEMATIC ANALYSIS OF PLANETARY TRANSMISSION USING SOLIDWORKS CAD GEOMETRY

D.1 Solidworks

Create a new part.

Set the dimensional tolerances and image quality to their maximum values.
Use these same high tolerance settings for the assembly. The gear teeth are not in contact and all components are mated correctly. Save assembly as type parasolid .x_t.

D.2 Considerations for backlash of planetary gears

The center distance method is not acceptable for the internal meshes of planetary transmission. One approach to achieve a desired backlash is to modify the position of the involute profile of the planet. First create the correct tooth, then linearly translate the profile one half the desired backlash. This will generate equivalent backlash in the sun-planet and planet-ring meshes.
D.3 ADAMS

Create a new model with default settings. This step must be done before importing the model.

In the Command Window enter:

defaults geometry display_tolerance_scale = 0.01

for units of mm. For English units the desired tolerance is 0.0005 in.
Decrease the simulation time by changing the solver thread count to 4. Import the parasolid assembly. Right-click → Browse. Right-click and assign mass to all parts, a new CM marker is generated.
A keyway is a realistic feature that creates an asymmetrical mass distribution in the plane of rotation. Consider the orientation of the part's CM triad. Add revolute and fixed joints to the correct bearing locations by building new markers with the desired orientation.

The model can be validated by applying motion to an input shaft.
The motion is a kinematic constraint that defines the rotation of the element as a function of time.
Applying initial velocities is discussed in Appendix C.4. For the application of torque, a step function can be scaled to represent an electric motor.
Solver time is reduced by deselecting Update graphics display and animating the completed simulations. Each time a simulation result is viewed in the postprocessor the computed variables are saved to the current .bin file. The size of the .bin increases rapidly when postprocessing. For aview2010 when the file size exceeds 250 MB the model may lose integrity and generate erroneous errors.

One approach to reduce file size is to export the .bin as a .cmd file, then create a new model and import the original. Define the defaults geometry display_tolerance_scale parameter from the Command Window before importing the .cmd file.
The plots of previous .bin databases can be retained by exporting the curves in spreadsheet format, then importing them as numeric data.

Change the independent axis to Data. MEA_1 is time, the other measures are the retained curves.

**D.4 ADAMS contact algorithm**

ADAMS offers two algorithms for the contact force: impact and restitution. The impact algorithm is numerically robust and best suited for multiple simultaneous contact events. The force vector between two objects is calculated using a classical mechanics model. The algorithm requires both objects to share a three dimensional penetration zone. In contrast, the restitution algorithm prohibits this unrealistic surface penetration between objects. The contact is modeled as an impulse with an energy penalty assessed on each event. Significant computational finesse is required to apply the restitution model in a planetary transmission. A fixed axis 23:31 external spur pair with a restitution coefficient of 1 is discussed in Appendix C.4.